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Trademarks 

The DCI logo, CableLink®, DataLog®, DigiTrak®, Eclipse®, iGPS®, Intuitive®, look-ahead®, SST®, target-in-
the-box®, and Target Steering® are U.S. registered trademarks and DucTrak™, FasTrak™, LT™, 
SuperCell™, TeleLock™, and TensiTrak™ are trademarks of Digital Control Incorporated. 

Patents 

The DigiTrak® Eclipse® Locating System is covered by one or more of the following U.S. Patents: 
5,337,002; 5,633,589; 5,698,981; 5,757,190; 5,764,062; 5,767,678; 5,878,824; 5,914,602; 5,926,025; 
5,933,008; 5,990,682; 5,990,683; 6,002,258; 6,005,532; 6,008,651; 6,014,026; 6,035,951; 6,047,783; 
6,057,687; 6,079,506; 6,095,260; 6,160,401; 6,232,780; 6,250,402; 6,396,275; 6,417,666; 6,454,023; 
6,457,537; 6,496,008; 6,525,538; 6,559,646; 6,653,837; 6,677,768; 6,693,429; 6,756,783; 6,756,784; 
6,768,307; 6,838,882; 6,924,645; 6,954,073; 7,015,697; 7,049,820; 7,061,244. Sale of a DigiTrak® 
Eclipse® Receiver does not convey a license under any patents covering the DigiTrak® Eclipse® Trans-
mitter or underground drill housing. Other patents pending. 

Limited Warranty 

All products manufactured and sold by Digital Control Incorporated (DCI) are subject to the terms of a 
Limited Warranty. A copy of the Limited Warranty is included with this manual along with your DigiTrak® 
Eclipse® DataLog® Mapping System; it can also be obtained by contacting DCI Customer Service, 800-
288-3610 or 425-251-0559, or by connecting to DCI's web site, www.digitrak.com.  

Important Notice 

All statements, technical information, and recommendations related to the products of DCI are based on 
information believed to be reliable, but the accuracy or completeness thereof is not warranted. Before 
utilizing any DCI product, the user should determine the suitability of the product for its intended use. All 
statements herein refer to DCI products as delivered by DCI and do not apply to any user customizations 
not authorized by DCI nor to any third-party products. Nothing herein shall constitute any warranty by DCI 
nor will anything herein be deemed to modify the terms of DCI’s existing Limited Warranty applicable to all 
DCI products. 

FCC Compliance Statement  

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to Part 15 of the Rules of the Federal Communications Commission. These limits are designed to provide 
reasonable protection against harmful interference in a horizontal directional drilling installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in ac-
cordance with the instructions, may cause harmful interference to radio communications or inaccurate 
readings on your DCI locating equipment. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful interference to radio or television recep-
tion, which can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

 Reorient or relocate the DigiTrak® Eclipse® Receiver. 
 Increase the separation between the problematic equipment and the DigiTrak® Eclipse® Receiver. 
 Connect the equipment into an outlet on a different circuit. 
 Consult the dealer for help. 

Changes or modifications to the DCI equipment not expressly approved and carried out by DCI will void 
the user’s Limited Warranty and the FCC’s authorization to operate the equipment. 
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Safety Precautions  
and Warnings 

IMPORTANT NOTE:  All operators must read and understand the following Safety Precautions 
and Warnings and must review this DigiTrak® Eclipse® DataLog® Mapping System Operator’s 
Manual as well as the DigiTrak® Eclipse® inGround Positioning System Operator’s Manual be-
fore using this system. 
 

 Serious injury and death can result if underground drilling equipment makes contact 
with an underground utility such as a high-voltage electrical cable or a natural gas 
line.  

 

 Substantial property damage and liability can result if underground drilling equipment 
makes contact with an underground utility such as a telephone, cable TV, fiber-optic, 
water, or sewer line. 

 

 Work slowdowns and cost overruns can occur if drilling operators do not use the 
drilling or locating equipment correctly to obtain proper performance. 

 

 Directional drilling operators MUST at all times: 

• 

• 

• 

• 

• 

• 

Understand the safe and proper operation of drilling and locating equipment, including the 
use of ground mats and proper grounding procedures. 

Ensure that all underground utilities have been located, exposed, and marked accurately 
prior to drilling. 

Wear protective safety clothing such as dielectric boots, gloves, hard-hats, high-visibility 
vests and safety glasses. 

Locate and track the drill head accurately and correctly during drilling. 

Comply with state and local governmental regulations (e.g., OSHA). 

Follow all other safety procedures. 
 

 The DigiTrak Eclipse system cannot be used to locate utilities. 
 

 Continued exposure to heat, due to frictional heating of the drill head, can cause inaccurate 
information to be displayed and may permanently damage the transmitter.  

 The DigiTrak Eclipse equipment is not explosion-proof and should never be used 
near flammable or explosive substances. 
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Safety Precautions  
and Warnings (Cont.) 

 Before each drilling run, test the DigiTrak Eclipse system to confirm that it is operating properly 
and check that it is providing accurate drill head location and heading information and accurate 
drill head depth, pitch, and roll information with the transmitter inside the drill head. 

 

 During drilling, the depth will not be accurate unless: 

• 

• 

• 

• 

• 

The Eclipse receiver has been properly calibrated and the calibration has been checked for 
accuracy so that the receiver shows the correct depth. 

The drill head has been located correctly and accurately and the receiver is directly above 
and parallel to the transmitter in the tool underground or above the front locate point (FLP). 

The receiver height-above-ground or ultrasonic distance has been set correctly. 
 

 Interference can cause inaccuracies in the measurement of depth and loss of pitch, roll, or the 
transmitter’s location or heading.  

Sources of interference include but are not limited to traffic signal loops, invisible dog fences, 
cable TV, power lines, fiber-trace lines, metal structures, cathodic protection, telephone lines, 
cell phones, transmission towers, conductive earth, salt water, rebar, radio frequencies, and 
other unknown sources of interference. 

Interference with the operation of the remote display may also occur from other sources 
operating nearby on the same frequency, such as car rental agencies using their remote 
check-in modules, other directional drilling locating equipment, etc. 

 

 Carefully review this operator’s manual and be sure you always operate the DigiTrak Eclipse 
system properly to obtain accurate depth, pitch, roll, and locate points. If you have any questions 
about the operation of the DigiTrak System, please call DCI’s Customer Service Department at 
425-251-0559 or 800-288-3610. 

 
 

REMEMBER 
If you are having difficulty on the job, call DCI (425-251-0559 or 
800-288-3610) and we’ll attempt to help you solve the problem. 
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Introduction 

               

  

Eclipse DataLog Receiver and Software Main Menu 

The DigiTrak® Eclipse® DataLog® Mapping System allows you to collect and store drill data electronically. 
The data is recorded using an Eclipse DataLog receiver, and then it is downloaded to a computer for 
analysis, printing, saving, and e-mailing. The following types of data can be measured and recorded with 
the Eclipse DataLog system:  

 Depth  
 Pitch 
 Elevation change (surface topography) 

This operator’s manual begins by describing the primary components of the DataLog system—the re-
ceiver, the computer software, the infrared (IR) cable that connects the receiver to the computer, and the 
special USB adapter, which is required for newer computers and laptops without serial ports. Then it 
presents procedures for using the DataLog menus on the Eclipse receiver; for recording drill data with the 
receiver; for installing and using the Eclipse DataLog software; for downloading the drill data from the 
receiver to the computer; and for viewing and editing the data. A quick reference for recording data in the 
field is given under “Recording Procedure Summary” in the Recording Data section.  

Some terms and techniques used in this manual are considered basic to the Eclipse locating system. If 
you have never used the Eclipse system, Digital Control Incorporated (DCI) strongly recommends that 
you read the operator’s manual for the Eclipse locating system (DigiTrak® Eclipse® inGround Positioning 
System Operator’s Manual) before you try using the DataLog system. 
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NOTE: You must know how to operate the Eclipse locating system prior to operating the 
Eclipse DataLog system. 

DCI also recommends that you read the instructions given in this DataLog system operator’s manual and 
familiarize yourself with the various menu screens on your Eclipse DataLog receiver before using the 
system for a production drill. If you have questions, please call DCI’s Customer Service Department at 
800-288-3610 or 425-251-0559. 
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System Components 
The Eclipse DataLog system has four main components: 

 Eclipse DataLog receiver – An Eclipse receiver upgraded to have the DataLog capability.  
 Eclipse DataLog software – Provided on CD along with this manual and sample drill data. 
 ACTiSYS infrared cable – Connects serial (COM) port or USB port on computer to infrared (IR) 

port on receiver.   
 USB-to-Serial Adapter – Converts serial connection to USB connection, which is required if your 

computer does not have a serial port.  
 

Eclipse DataLog Receiver 
The Eclipse DataLog receiver can record and store 25 bores or runs before downloading is necessary, 
and each run can have up to 250 data points. Operation is simple, with Intuitive® menus and two-button 
(toggle and trigger) operation. (See Using DataLog Menus on Receiver section.)  

          

Display 
Screen Toggle

Switch 
Trigger 
Switch 

Speaker 
Infrared 
Port 

Eclipse DataLog Receiver Side View (left) and Top View (right) 

The DataLog system requires that drill data be recorded at equivalently spaced locations, such as at the 
end of each drill rod. If you have long drill rods, say 30 ft (19 m) long, and there are considerable pitch 
changes over one rod, then you may want to record data more frequently than once per drill rod. The 
distance between data recordings is called the rod length. (See Recording Data section.) 

From this point forward in this manual, the Eclipse DataLog receiver will often be referred to as simply the 
receiver. Any Eclipse receiver can be upgraded to have the DataLog capability. 
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System Components  

Eclipse DataLog Main Application Window 

 

Eclipse DataLog Software 
The Eclipse DataLog software  is provided on 
a single CD-ROM, which also contains this 
operator’s manual and sample drill data. The 
DataLog software requires a computer with at 
least the following system specifications: 

 600 MHz or greater processor  
 Microsoft Windows 98, 2000, or XP opera-

ting system 
 Serial (COM) port or USB port 
 Pointing device (mouse)  
 Color printer for color graphs  

Software installation instructions are given later 
in this manual (see Installing DataLog Software). 

ACTiSYS Infrared Cable 
The ACTiSYS infrared (IR) cable has a serial 
plug at one end and an IR reader at the other 
end. To download data from the receiver to the 
computer, the IR reader must be placed over the 
receiver’s IR port, and the serial plug must be 
connected to the computer. Then, using the 
receiver’s menus and the Eclipse DataLog soft-
ware, the data is transferred to the computer. If 
the computer does not have a serial port, a 
serial-to-USB adapter must be used; it is pro-
vided with the IR cable.  

The ACTiSYS IR cable is provided by DCI with 
the Eclipse DataLog system. For replacements, 
please contact the manufacturer ACTiSYS Cor-
poration (www.ACTiSYS.com) and reference 
ACTiSYS Part No. ACT-IR220L+. 

ACTiSYS Infrared Cable 

 
IR Reader

Serial Plug

Port Authority USB Serial DB9 Adapter 

 

USB Plug 

Serial Plug

USB-to-Serial Adapter  
The USB-to-serial adapter is required to connect 
the ACTiSYS IR cable to the computer if the 
computer does not have a serial port. The 
adapter provided by DCI is a Port Authority USB 
Serial DB9 Adapter. Replacements are available 
from www.CablesToGo.com.  
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Using DataLog Menus  
on Receiver  

Enabling the DataLog Function 
The receiver has a set of DataLog menus for operating the DataLog system. To view the DataLog menu 
options, you must first enable the DataLog function. The DataLog function will then display as an option 
on the Eclipse main menu. Once the DataLog function is enabled it will remain on until you disable the 
function, even if you turn the receiver off. You will not lose any drill data that has been collected by turning 
the receiver on and off or by enabling and disabling the DataLog function. 

To enable the DataLog function:  

1. From the Eclipse main menu (where the menu options are Locate, Power Off, Set US, 
Configure, and High/Low Fre), toggle to the Configure option and click the trigger.  

2. Then toggle to the right several times to Locator DL and click the trigger. This menu option will 
then display as No Locator DL.   

 

Disabling the DataLog Function  
You may want to disable the DataLog function, especially if you are not using it regularly. One reason to 
disable the DataLog function is to avoid getting the “Start DataLog” message if you accidentally push the 
toggle switch up while in locate mode. When the DataLog function is disabled, you will not see the 
DataLog message when you toggle up while in locate mode. 

To disable the DataLog function: 

1. From the Eclipse main menu, toggle to the Configure option and click the trigger.  

2. Then toggle to the right several times and click on No Locator DL.  

 
NOTE: When the DataLog Function is disabled, you will not see DataLog listed as an option on 

the Eclipse main menu. 

 
 

Receiver DataLog Menus 
To view the DataLog function options, which are located on the Eclipse main menu after the DataLog 
function has been enabled, toggle down once, then toggle right several times to DataLog and click the 
trigger. You will then see the DataLog main menu screen. 
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Selection 
Arrows 

Scroll Right 
Arrow 

DataLog Main Menu Screen 

The DataLog main menu screen shows only the first two DataLog menu options. The Send Locate Data 
option is currently selected, as indicated by the selection arrows surrounding it. The scroll right arrow at 
the end of the menu bar, just after the Delete Locate Data option, indicates there are more options to the 
right. To see the other options, toggle right. The other options are List Saved Run Number, Change 
Run Number, and Set Survey Point. 

 
DataLog 

Delete Locate Data List Saved Run Number Change Run Number Set Survey Point 

Locate DataLog 

Send Locate Data 

From Eclipse Main Menu 

Change Survey PointSet to Blank 
 

Eclipse Receiver DataLog Menus 

To use the DataLog menus, select a menu option using the toggle, then click the trigger. The available 
menu options and their functions are described below. 

 Send Locate Data – Sends drill data from the receiver to the computer via the IR cable. 

 Delete Locate Data – Deletes all data stored in the receiver.  
 

WARNING: The Delete Locate Data option will delete ALL data in the receiver. You cannot 
clear specific runs. Be sure you have downloaded and saved the data on your com-
puter before you use this menu option. Once the data is deleted from the receiver, it 
cannot be retrieved. 
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 Using Receiver Menus 

 List Saved Run Number – Lists all run numbers stored in the receiver. Used to determine the 
next run number to assign when starting a new run or bore.  

 Change Run Number – Displays the last run number used, and allows you to change the run 
number. Used when assigning a run number to a new run.  

 Set Survey Point – Allows you to enter the survey point, which is the change in elevation be-
tween the first data point recorded in a run and the last point recorded (the difference between 
the launch point elevation and the exit or termination elevation).  

The Set Survey Point menu has two submenus: 

 Set to Blank – Used when you do not know the difference between the launch point 
elevation and the exit point elevation (survey point). Selecting this option will result in the 
topography and survey point being calculated strictly from the tool’s pitch. 

 Change Survey Point – Used to enter or change the survey point (that is, the difference in 
elevation between the launch point and the exit point) for that run. The survey point can also 
be entered and changed in the computer after download (see more information under 
“Changing the Survey Point” in the Editing Data in Computer section). 

 

Data Recording Options 
The receiver must be in locate mode to start the DataLog recording process, then toggle up, select Y for 
yes, and click the trigger. To record a data point, push the toggle up to advance to the data recording 
options screen (shown below). Several options are provided for different situations, like road or creek 
crossings where the receiver cannot be positioned above the front locate point (FLP) to record data. The 
available recording options, Depth & Pitch, Pitch Only, Blank, and Exit, are explained below. 

NOTE: To record data, the receiver must be positioned above the front locate point (FLP), except 
for in a few cases (see below). If you are not familiar with the procedure for finding the FLP, 
please refer to the locating section in the Eclipse system operator’s manual. 

 

Data Recording Options Screen  
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Using Receiver Menus  

The data recording options are as follows: 

 Depth & Pitch – Used when the receiver is positioned over the FLP to take both depth and pitch 
recordings. This is the most common option to select, and it is the default setting.  

 Pitch Only – Used when the receiver cannot be positioned over the FLP but can be positioned 
within range of the transmitter. Only pitch information is recorded. 

 Blank – Used when the receiver cannot be positioned within range of the transmitter. Records a 
blank data point.  

 Exit – Used to exit the DataLog recording function and return you to DataLog locate mode with-
out recording anything.  

The Pitch Only and Blank options will allow you to enter or confirm values after you have downloaded 
the drill data to the computer (see “Correcting for Taking Pitch Only or Blank Data” in Editing Data in 
Computer section). 

NOTE: When using the Pitch Only or Blank options, you will be prompted after download to 
enter values or to accept values interpolated by the DataLog program.  

 

Setting or Changing the Run Number  
You will need to use the Change Run Number command to assign a run number when you are starting a 
new run. You may also need to use this command when selecting which run to download to computer.  

To change the run number: 

1. Toggle right to select DataLog from the Eclipse main menu, then click the trigger. 

2. Select Locate DataLog, then click the trigger. 

3. Toggle right to select Change Run Number from the DataLog main menu, then click the trigger. 
The last run number that was used is displayed above the Change Run Number menu option.  

4. Push the toggle up to advance to the next run number, or toggle up and down as needed to 
select the desired run number, then click the trigger. 

5. You will be asked if you are sure. Use the toggle to select Y or N, then click the trigger. 

6. The requested run number will be shown on the screen. 
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Recording Data  

Data Recording Procedure 
To record data, the receiver must be properly calibrated and powered up with the drill head threaded onto 
the drill. The DataLog function must be enabled on the receiver, as discussed in the last section under 
“Enabling the DataLog Function”, and then the receiver must be set to record before you can start 
recording data. The correct procedure is described here. A summary of the procedure is provided in the 
next section entitled “Recording Procedure Summary.” 

Setting Up Receiver  

You must set up the receiver every time you start a new run.  

1. Select “DataLog” from Eclipse Main Menu  
To start up the program, toggle right to select the DataLog option from the Eclipse main menu, then 
click the trigger. 

 

2. Select “Locate DataLog”  
Use the toggle to select Locate DataLog, then click the trigger to advance to the DataLog main menu 
screen.  

 

3. Select “List Saved Run Number,” if necessary 
Toggle right to select List Saved Run Number, then click the trigger. If this is the first run, no run 
number will be assigned, so you can skip this step and proceed to step 5. If run numbers have been 
assigned, then the “Total Saved Run Number” screen will list those numbers. The run numbers 
should be consecutive from 1 to a maximum of 25. Make a note of any numbers that are missing in 
the run number list, and use the first unused number for your next run number. 

NOTE: You cannot save more than 25 runs in the receiver at any one time. If you attempt to 
store more than 25 runs before deleting data, you could lock up the receiver and lose all 
drill data it has stored. This may require the receiver to be returned to DCI for repair. 

 

4. Select “Change Run Number” 
Toggle right to Change Run Number, then click the trigger. Toggle up or down to change the run 
number if necessary, then click the trigger to see the Change Run Number confirmation screen, 
shown below.  
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Recording Data  

Change Survey Point

 

Change Run Number Dialog Box 

Confirm the run number by selecting Y for yes. You will then get another confirmation box showing 
the new run number. Click the trigger to confirm the number and return to the DataLog main menu. 
(See “Setting or Changing the Run Number” at the end of this section.) 

 

5. Select “Set Survey Point”  
Toggle right to select Set Survey Point, and then click the trigger. You will see two menu options: 
Set to Blank and Change Survey Point.  

 

Set Survey Point Menu Options 
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 Recording Data 

Set to Blank 
If you do not know the survey point, then select Set to Blank and click the trigger to get to the 
Change Survey Point confirmation box. 

 

 

Change Survey Point Dialog Box 

You will then get a confirmation message that the survey point is now blank. 
 

 

Survey Point Confirmation Dialog Box 

NOTE: Prior to downloading the data for that run, you can change the Set to Blank option.  
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Recording Data  

Change Survey Point 
Toggle up or down to enter a value for the survey point, which is the difference in elevation from the 
launch point to the exit or termination point of the bore. It is not necessary to have the distance for the 
survey point surveyed, as long as you can confidently estimate the change in elevation.  

The survey point is entered as feet or meters, depending upon the depth measurement units selected 
on the receiver. It will be positive if the ground level is higher at the end of the run, and negative if the 
ground level is lower at the end of the run. If the value is negative, you must enter a “–” (minus) sign; 
a “+” sign is not needed when entering a positive value. For example, if the exit point is 6 ft 7 in. (or 
6.58 ft/2.0 m) lower than the entry point, the survey point will be “–6.6”. Note that the survey point is 
expressed with only one significant digit after the decimal point; that is, it is expressed in numbers to 
the tenths. 

 

 

Scroll Left 
Arrow Pop-up 

Box 

Survey Point Menu Option with Value Entered in Pop-up Box 

 
After you enter a value for the survey point, click the trigger. You will then see the Change Survey 
Point confirmation box. Toggle right to select Y for yes, then click the trigger. An Eclipse Message 
dialog box will then appear showing the new value for the survey point. 
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 Recording Data 

 

Survey Point Confirmation Dialog Box 

 
Click the trigger to confirm that the value for the survey point is correct. You will return to the DataLog 
main menu. 

NOTE: The survey point can also be entered and changed in the computer after the data is 
downloaded. See “Changing the Survey Point” in the Editing Data in Computer 
section.  

 
 
6. Return to Locate Mode 

Toggle down twice from the DataLog main menu to return to the Eclipse main menu. Then select the 
Locate menu option, and click the trigger to return to locate mode. 

NOTE: To return to locate mode from the DataLog main menu, simply toggle down three 
times, and then click the trigger. 
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Recording Data  

Recording Data in the Field 

Now that you have set up the receiver, you can begin to record data according to the following procedure.  

 
1. Position Drill Head at Entry of Run (Launch Point) 

Push the drill head into the ground so that the housing slots are half above and half below the ground 
(or a plane parallel to the ground if drilling into a pit). This is the position the drill head needs to be in 
before you can record the first data point (see sketch below). The elevation at the first data point is 
referred to as the zero reference elevation—this elevation is generally at the surface of the ground 
where the first data point is recorded.  

      

Surface of Ground 
or Zero Reference 

Elevation 

Drill Head 
Entering 
Ground 

Slots in 
Housing 

  

Positioning Drill Head for First Data Point 

2. Measure and Record 1st Rod Length 
With the drill head correctly positioned, measure and document the 1st Rod Length. The 1st Rod 
Length is measured from the make-up/break-out clamps to the top of the rod. This measurement is 
not entered into the receiver, but it is needed when downloading the data to computer.  

The Rod Length, which is also only entered in the computer at the time of downloading, is the 
distance between data recordings. This distance, which must be constant, is typically the length of 
one drill rod.  

 

Top of Rod 

Slots in Housing

1st Rod Length

Make-up/Break-out 
Clamps 

Drill 
Carriage 

Zero Elevation 
Reference Line  

Surface of 
Ground  

1st Rod Length 
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3. Start DataLog Recording 
From the locate mode screen, push the toggle up once to see the Start DataLog dialog box.  

 

Start DataLog Dialog Box 

Toggle right to select Y for yes, then click the trigger. You are now in DataLog locate mode. The 
receiver display will appear as shown below. 

 

DataLog Locate Mode Screen 

NOTE: If you are starting a new run and the rod number is not zero, then the run number 
shown has already been used, and you must change the run number. 
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4. Record First Data Point (Launch Point) or Rod 0 
The receiver does not need to be specifically positioned to record the first point as long as it is within 
range of the transmitter. To record the first point, push the toggle up once. You will see the data 
recording options screen with the following options: Depth & Pitch, Pitch Only, and Exit.  

 

Data Recording Options Screen  

NOTE: Pushing the toggle up once while in DataLog mode locks the data on the screen and 
stops signals from being sent to the remote display. 

 
 
5. Select “Pitch Only” Recording Option  

Verify that the data locked on the screen is correct—if it does not appear to be, then select Exit and 
repeat step 4. Once the data appears correct, then toggle right to select Pitch Only, and click the trig-
ger. You will hear one short confirmation beep, and the rod number will automatically increase to 1.  

NOTE: The receiver does not need to be positioned over the FLP when recording the pitch 
value for the first data point (Rod 0).    

 
 
6. Advance Tool to End of First Rod 

Advance the tool to the end of the first rod. We suggest that you mark the rod number on the ground. 
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7. Position Receiver at FLP  
Position the receiver at the FLP (if possible) for a data recording. Then push the toggle up to display 
the recording options: Depth & Pitch, Pitch Only, Blank, and Exit.  

 

Data Recording Options Screen  

NOTE: If the FLP is not accessible or safe, use the Pitch Only or Blank recording options. 

 
 
8. Select Recording Option 

Select the appropriate recording option, then click the trigger. You will hear a short confirmation beep, 
and the rod number will increase by one. You have now recorded the second data point, which is at 
the end of the first rod.  

 
 
9. Advance Tool One Rod Length 

Advance the tool one rod length. 

 
 
10. Position Receiver at FLP  

Position the receiver at the FLP (if possible) for a data recording. Then push the toggle up to display 
the recording options: Depth & Pitch, Pitch Only, Blank, and Exit.  
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11. Select Recording Option 
Use the toggle to select the appropriate recording option, then click the trigger. You will hear a short 
confirmation beep, and the rod number will increase by one. 

 
 
12. Repeat Steps 9 through 11 Until at Exit Location 

Continue to repeat steps 9 through 11 until the tool is at the exit location and you are ready to record 
the last data point. If you need to pull back rod(s) to resteer during the bore, refer to “Pulling Back 
Rods” later in this section for the proper procedure. 

 
 
13. Measure and Document Last Rod 

At the end of the run, with the tool at the exit location, you must measure and document the length of 
the Last Rod so that you can enter it when you download the drill data to the computer. The Last Rod 
measurement is the rod length minus the length of drill rod left on the rack. For example, if you 
measure 6 ft (1.8 m) from the make-up/break-out clamps to the top of the rod, then you would sub-
tract 6 ft (1.8 m) from the rod length. If the rod length is 10 ft (3.0 m), then the Last Rod measurement 
will be 4 ft (1.2 m).  

NOTE: If the depth of the Last Rod is less than 24 in. (61 cm), you must set the ultrasonics 
and log the last data point above the ground level for an accurate depth reading, or 
you can record pitch only. 
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14. End DataLog Recording  
After recording the last data point and documenting the Last Rod, push the toggle down once. You 
will see the End DataLog dialog box. 

 

 

End DataLog Dialog Box 

Select Y for yes, and click the trigger. You are now back in locate mode.  

NOTE: Exiting DataLog mode or shutting off the receiver will not affect the saved data. 
Each time a DataLog run is started, it defaults to the last rod recorded for that run. 

If you want to include utilities with your drilling data, you must hand log the depth, description, rod 
number, and/or distance from the launch point for each utility location. When you download your data 
to the computer, these utilities and any other landmark features can be entered and plotted with the 
drill data.  

 
 
15. Return to Eclipse Main Menu 

To return to the Eclipse main menu, push the toggle down once. 

 
 
Congratulations!  You are now ready to record another run or to download this run to the computer. 
For downloading instructions, see the Downloading Data to Computer section. 
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Recording Procedure Summary  

Setting Up Receiver  

1. Select “DataLog” from Eclipse Main Menu  
2. Select “Locate DataLog”  
3. Select “List Saved Run Number” 
4. Select “Change Run Number” 
5. Select “Set Survey Point” 
6. Return to Locate Mode 

 

Recording Data in the Field 

1. Position Drill Head at Entry of Run (Launch Point) 
2. Measure and Record 1st Rod Length 
3. Start DataLog Recording (toggle up from locate mode) 
4. Record First Data Point (Launch Point) or Rod 0 (position receiver anywhere within 

range of the transmitter, and toggle up) 
5. Select “Pitch Only” Recording Option  
6. Advance Tool to End of First Rod 
7. Position Receiver at FLP (if possible) 
8. Select Recording Option 
9. Advance Tool One Rod Length 
10. Position Receiver at FLP  
11. Select Recording Option  
12. Repeat Steps 9 through 11 Until at Exit Location 
13. Measure and Document Last Rod 
14. End DataLog Recording (toggle down) 
15. Return to Eclipse Main Menu (toggle down) 
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Pulling Back Rods  
If you need to pull back rods to redirect the tool, use the pullback procedure given below. Please note, 
you must communicate with the drill operator to ensure that you are both pulling back the same rods. 

1. While in DataLog locate mode, push the toggle left once. You will see the Start Pulling Back 
dialog box.   

 
Start Pulling Back Dialog Box 

2. Push the toggle right once to select Y for yes, then click the trigger. You will see “(p)” next to the 
rod number to indicate it has been pulled back (see pullback mode screen shown below). You will 
also see that the rod number has decreased by one. 

 
Pullback Mode Screen 
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3. For each additional rod that is pulled back, push the toggle left once. You will see the rod number 
decrease every time you push the toggle left. There may be a short delay before you see the 
number change.   

4. When you are done pulling back rods, push the toggle right once. You will see the Stop Pulling 
Back dialog box. 

 

Stop Pulling Back Dialog Box 

5. Push the toggle right once to select Y for yes, then click the trigger. You will return to DataLog 
locate mode. 

6. You are now ready to start rerecording the rods you pulled back. 

 

NOTE: Once rods have been pulled back and marked with a “(p)”, they cannot be pulled back 
again until they have been rerecorded. For example, if Rods 12 and 13 are pulled back, 
then you must redrill and rerecord those rods before you can pull them back again. You 
can also simulate redrilling by recording Blanks for both Rods 12 and 13 without actually 
advancing the tool. 
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Installing DataLog Software  

Computer System Requirements 
The Eclipse DataLog computer software is provided on a single CD-ROM, which also contains the opera-
tor’s manual, two sample projects, and sample drill data. The DataLog software requires a computer with 
at least the following system specifications: 

 600 MHz or greater processor  

 Microsoft Windows 98, 2000, or XP operating system 

 Serial (COM) port or USB port 

 Pointing device (mouse)  

 Color printer for color graphs  

 

Installing Software on Computer 

NOTE: Files will automatically be placed under the C:\Program Files folder in a new folder named Digital 
Control Incorporated (C:\Program Files\Digital Control Incorporated). You can change this default 
storage location during installation. 

Eclipse DataLog Software  

1. Close any open applications.   

2. Place the DataLog CD-ROM in the CD drive and follow the prompts. The software will install 
automatically. You will be given an opportunity to change the default storage location during 
installation. 

3. Once the program is installed, you will see an Eclipse DataLog shortcut icon    on your desktop 
and under All Programs in your Start menu (in lower left corner of computer screen).  

 
Software for USB-to-Serial Adapter  

If you do not have a serial port on your computer, then you will need to use the USB-to-serial adapter 
provided with the DataLog system. This adapter requires you to install software on your computer.  

1. Close any open applications.   

2. Place the CD-ROM provided with the USB-to-serial adapter in the CD drive, and follow the 
prompts. The software will install automatically. 
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Notes 
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Using DataLog Software 

Starting DataLog Program 
There are three ways to start the Eclipse DataLog program:  

 Double-click on the Eclipse DataLog icon    on the desktop. 

 Use the Start button (in lower left corner of computer screen) and select Start | All Programs | 
Eclipse DataLog |    Eclipse DataLog. 

 From Windows Explorer, click on the EclipseDataLogger.exe file in the C:\Program Files\Digital 
Control Incorporated\Eclipse DataLog folder, or the folder you have designated for the storage 
location.  

After you start up the program, you will see the main application window without data, as shown in the 
figure below. This window serves as a blank form for a new project (it is also generated by using the File | 
New command on the menu bar). The main features and information fields identified on the blank project 
screen below are described after the figure. 

 

 

Menu Bar 
DATA FieldTitle Bar 

Drill Info 
Field 
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Field 

Required for 
Download 
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Field 
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Port Close 
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Data Input 
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Download) 
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(Cursor 
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DataLog Main Application Window  
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Menu Bar 

Under each menu on the menu bar (File, Edit, Port, View, and Help) are commands for running the 
Eclipse DataLog program. Many of the commands are similar to those used in other Windows programs. 
This is particularly true for the File and Help menu commands. The menu commands are summarized 
below. 

File Menu Commands 

 New – Creates a new blank project screen.  
 Open – Opens an existing project. 
 Save – Saves an opened project using the same file name. 
 Save As – Saves an opened project to a specified file name 

and folder. 
 Print – Prints a project. 
 Print Preview – Displays the project on the screen as it would 

appear printed. 
 Print Setup – Selects a printer and printer connection. 
 Previously Opened Files – Allows you to click on the filename 

of a recently opened project to open the file immediately. 
 Exit – Exits Eclipse DataLog program. 

Edit Menu Commands 

 

 Run Info – Allows entry or editing of data in the Run Informa-
tion field, which includes project, customer, and contractor data 
and displays the measurement units required for downloading. 
(See “Changing Data or Adding Comments in DATA Field” in 
the Editing Data in Computer section.)  

 Utility Flags – Opens a dialog box for viewing, adding, deleting, or changing utility locations, 
which are shown on the profile view. (See “Profile View of Run” later in this section.) 

 Last Rod Data – Opens a dialog box for entering or changing the pitch and depth data for the 
last rod. If you make a change to the last rod data, click OK. You will see the profile change and 
an asterisk appear in the DATA field in the row for the last rod. (See “Changing Last Rod Data” in 
the Editing Data in Computer section.) 

Port Menu Commands 

The Port menu has four options, which are listed as 1, 2, 3, and 4. 
These numbers represent the COM ports available. The Port menu 
is used to select a port for downloading data.  

To determine the computer’s available ports, open your computer’s 
Control Panel and click on the System icon to open the System 
Properties dialog box. Click on the Hardware tab and then the Device Manager option at the top to 
open the Device Manager dialog box. Click on “Ports” in the listing to view the available ports on your 
system.  
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View Menu Commands | Pulledback Rods 

 The View menu has only one command: Pulledback Rods. This 
command opens a dialog box for viewing the project data on 
pulled-back rods. 

Help Menu Commands 

 

 Help Topics – Opens Eclipse DataLog Help 
file. 

 Search – Allows user to search for terms in 
Help file. 

 About Eclipse DataLog Software – Provides software version number and copyright information 
for Eclipse DataLog software. 

Run Information Field 

The Run Information field displays some basic information 
about the run (pilot hole), including location, date, time, and 
measurement units. The measurement units must be en-
tered into the computer prior to downloading the drill data 
for that run. The location, date, and time information may be 
entered later. To enter or change the run information, select Run Info from the Edit menu. You will see 
the Run Information dialog box (see “Editing Run Information” in the Editing Data in Computer section).  

 

                  

Specify 
Measurement 
Units Here 
Before 
Downloading 

Run Information Dialog Box 
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If the units are not specified in the Run Information dialog box, the DataLog system will automatically use 
the default units of feet and percent.  

Drill Information Field 

 

 Run Number – The run number that was assigned  
in the receiver. 

 Drilled Rods – The number of rods drilled and re-
corded by the receiver for this run. 

 Eclipse S/N – The serial number of the Eclipse receiver used to record the run, which should 
download into the computer automatically with the drill data. The serial number is located on the 
front of the Eclipse receiver; it is preceded by the letters EDRR. Older Eclipse receivers may 
require you to input the serial number manually.  

 PullBack Rods – The total number of rods pulled back (for resteering). Each rod can be pulled 
back and redrilled a maximum of five times. 

 Survey Point – The change in elevation between the first data point recorded in a run and the 
last data point. The survey point is recorded in either feet or meters, depending on the units you 
are using for depth. It will be positive if the ground level is higher at the end of the run, and 
negative if the ground level is lower at the end of the run. A minus “–” sign must be entered if the 
value is negative.  

The survey point can be entered either into the receiver or into the computer after data download. 
If the survey point is not entered into the receiver or into the computer before download, the 
computer will assign a default value of “Blank”, which is a good value to use if the survey point is 
not known.  

Changing Survey Point – You can change the survey point after download by entering a new 
value in the Drill Information field. If you do change the survey point, you must then click on the 
PLOT button (see “PLOT Button” description below) so that the drill data and topography adjust 
accordingly. 

 

DATA Field 

 

The DATA field lists information about each 
rod in the run. Each of the data fields is de-
scribed below.  

 Rod – A sequential listing of each 
data point recorded (typically one rod 
length). Rod 0 is the first data point 
(or launch point), taken when the 
slots in the drill housing are half 
above and half below the ground (or a 
plane parallel to the ground if drilling 
into a pit). 
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 Distance – The horizontal distance from the launch point. 

 Pitch – The inclination of the transmitter. 

 Depth – The depth of the transmitter as recorded by the receiver (see drawing below). 

 iDepth – The integrated depth of the transmitter, as calculated from the pitch and the zero 
reference elevation. Note that when the values for Depth and iDepth are not identical, a change in 
topography has occurred (see drawing below). 

 Rel. Elev. – The relative elevation, or the change in elevation, based on the zero reference estab-
lished at the first data point (see drawing below). 

 Type – The data option used to record the data (see “Data Recording Options” in the Using 
DataLog Menus on Receiver section). For Depth & Pitch data, no notation occurs. For Pitch 
Only data, the value will be “p”; and for Blank data, the value will be “b”. The p and b values may 
be used on road or creek crossings when the receiver cannot be placed at the front locate point. 
An asterisk (“*”) appears in the Type column if the data for that rod has been changed in the 
computer. An “a” will appear if rods have been added (see Editing Data in Computer section). 

 Comments – Allows you to enter one line of information related to that data point, such as GPS 
coordinates, change in drilling conditions, landmarks, etc. These comments will appear in the 
printed report directly beneath that rod’s drill data.   

You can edit the Pitch, Depth, and Comments fields by double-clicking your cursor in the row where you 
want to edit data. You will then get the Data Record dialog box (see “Changing Data or Adding Com-
ments in DATA Field” under the Editing Data in Computer section). You can also right click on a row in 
the DATA field to edit, insert, or delete a row (“Editing, Inserting, or Deleting Rod Data” under the Editing 
Data in Computer section). 
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Port Status Field and Open/Close Buttons 

 

Close

OpenThe input box in the top right corner of the software screen displays the port 
status. Before downloading data, you must connect the receiver and computer 
using the ACTiSYS IR cable, and the USB-to-serial cable if necessary, through 
an available port. To choose a port, select the desired port number (1, 2, 3, 4) 
from the Port menu (port 1 is generally used), then click on the Open button. 
To disconnect from a port, click on the Close button.  

If you cannot open a port after you have identified one using your computer’s system properties hardware 
settings in the Control Panel (see “Port Menu Commands” earlier in this section), close the Eclipse 
DataLog program and reopen it. Select the desired port, and click on the Open button. If this does not 
solve the problem, then call DCI Customer Service, 800-288-3610 or 425-251-0559, for assistance. 
 
 
 
Rod Length Data Input Fields 

 

After you have selected a port, you are prompted to enter values for the rod 
length data input fields: Rod Len, 1st Rod, and Last Rod. These data fields must 
be filled in or download will not occur.  

 Rod Len – The rod length (Rod Len) is the distance between data 
points, which must be constant. The rod length is typically the length of 
one drill rod.  

 1st Rod – The 1st Rod is the rod length for the first data point (launch point), which is usually a 
partial rod. This value is determined by measuring the amount of drill rod left on the rack from the 
make-up/break-out clamps to the top of the rod when the launch point is recorded. This length is 
required for download to occur. 
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 Last Rod – The Last Rod is the rod length for the last data point, which is usually a partial rod. 
This value is determined by measuring the length of drill rod left on the rack from the make-up/ 
break-out clamps to the top of the rod and then subtracting this distance from the rod length. For 
example, if the length of rod left on the rack is 6 ft (1.8 m), and your rod length is 10 ft (3.0 m), the 
Last Rod will measure 4 ft (10 ft – 6 ft = 4 ft) or 1.2 m (3.0 m – 1.8 m = 1.2 m). This length is 
required for download to occur. 
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PLOT Button 

The PLOT button is used to replot the data in the profile view area at the bottom 
of the screen. Whenever you edit the survey point data or any other drill data, 
you should then click on the PLOT button to replot the data; you will see the graph shift as the data is 
replotted. 

 
PLOT 

 

 

Profile View  
of Run  

The bottom portion of 
the DataLog main ap-
plication window shows 
the profile view of the 
run. The flag marked 
“S” at the far left identi-
fies the start of the run 
and the first data point, 
at which the elevation 
is considered zero. The flag marked “T” represents the termination or end of the run. Note the OnBar or 
cursor location line (dashed vertical line) and the cursor coordinates. As you move the cursor around in 
the plot area, you can see the coordinates change to show the cursor’s location. 
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To better explain the data information displayed in the profile view, we will use one of the sample projects 
provided with the DataLog program. To open a project, select the File | Open menu command and select 
the first sample project file (Sample 1 Project.dld), which should be under a folder named Drill Data. You 
will then see the project screen, with the profile view in the lower half. The main features shown in the 
profile view are identified and described below.   

 

Utility Flag Termination 
Marker Surface 

Topo 

Data Point 
Info (Rod 16) 

Run  
Profile 

Start  
Marker 

Project Data for Sample 1 Project 

 Data Point (Rod) Information – The data point information gives the rod number, the horizontal 
distance from the start, and the depth of the transmitter. In the example shown above, the cursor 
was placed as close as possible to the data point for Rod 16. Note that the numbers in the box 
(16: 159.8, 6.0) correspond to the data for Rod 16 in the DATA field (horizontal distance from 
launch point = 159.79; depth below surface topography = 5.98).  

 Surface Topography – The upper line of the plot shows the surface topography, as measured at 
each data point. 

 Run Profile – The lower line of the plot shows the run profile. 
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 Utility Flags – There are seven preset utility flags used to show the locations of utilities, including 
water, power, telephone, gas, cable, sewer, and miscellaneous. The utility data can be viewed 
and edited by selecting Utility Flags from the Edit menu (Edit | Utility Flags) to display the 
Utility Flags dialog box.  

 

Utility Flags Dialog Box  

Opening Project Files  
1. To open an existing drill project from within the DataLog program, select Open from the File 

menu. You will see the Open dialog box and a list of available DataLog project files (with the file 
extension “dld”) in the folder that was last used. If this is the first time the program is being used, 
however, the Open dialog box will show the Drill Data folder under the Eclipse DataLog program 
file, which is the default location for storing project files (C:\Program Files\Digital Control Incor-
porated\Eclipse Datalog\Drill Data).   

 

Open Dialog Box 
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2. Select the desired Eclipse DataLog project file (in this example, Sample 1 Project.dld), or 
navigate to the folder where you have stored your project files and select the desired file. Then 
click on the Open button. You will see the main application window.  

 

Printing and Previewing Project Reports (Profile and Drill Data) 
1. If you want to preview the printed pages before you send the file to print, select Print Preview 

from the File menu. 

2. To print the project data, select Print from the File menu. You will see the Print dialog box.   

3. Make any adjustments needed in the Print dialog box, then click OK. If you have the Adobe 
Acrobat PDF writer software, you can select the Adobe PDF printer to print to a PDF file (see 
your Adobe software documentation). 

4. The project data will print on at least two pages. On the first page, the run information will appear 
at the top and the profile view plot at the bottom. The second page (and more if needed) will list 
the drill data shown in the DATA field.  

    

Print Preview of Drill Data 

If the run is long, you may prefer to print the profile view in landscape mode so that it will print 
larger. To do so, select Print Setup from the File menu and click on Landscape under Orienta-
tion. Then you can print page 1 (the profile view) in the landscape orientation, or you can choose 
to print all pages in the landscape orientation.  
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Saving Project Files 
1. To save an open project file, select Save from the File menu. The file will automatically be saved 

under its current file name (shown on the left in the blue title bar at the top of the main application 
window) and location. If the project has not yet been saved and named, then the file will automa-
tically save to the default file name EclipseDataLogger.dld. 

2. To save a file with a different file name or location, select Save As from the File menu. You will 
see the Save As dialog box, which automatically opens to the folder where the current file is 
stored.  

 

Save As Dialog Box 

3. Change the file name and location as desired, then click Save. The open file will now have the 
new file name and/or location. 

 

 

E-mailing Project Files 
You can send Eclipse DataLog project files via e-mail. E-mailed files can be opened on any computer that 
has the same version of the Eclipse DataLog software as used on the originating computer.  

The Eclipse DataLog program generates two files for each run. Each file has a different file extension 
after its name—for example, one will be named “Projectname.dld”, and the other “Projectname 
Profile.oc2”. Both files are required to be in the same folder for the project data to display correctly.  

NOTE: Both project files (the *.dld and *.oc2 files) must be e-mailed and saved to the same 
folder on the receiving computer so that the data will display correctly. 
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To e-mail files for a project, select the two project files (the *.dld and *.oc2 files) as attachments in your e-
mailing application, and then send the e-mail. The default location of the Eclipse DataLog program data is 
C:\Program Files\Digital Control Incorporated\Eclipse Datalog\Drill Data. You can see the different file 
types under the Drill Data folder by setting the drop-down selection at the bottom of the dialog box to “All 
Files (*.*)”, as shown below.  

 

Open Dialog Box Showing “All Files” 

 
NOTE: If you have made a PDF file of the project data, then you can select the PDF file for 

e-mailing. 
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Downloading Receiver’s  
Data to Computer 

Downloading Data from Receiver to Computer 
To download drill data, you will need the receiver (containing the drill data to download), the ACTiSYS IR 
cable and USB adapter, and a computer with the Eclipse DataLog software installed (see Installing 
DataLog Software section).  

DCI recommends that you use an AC power source when downloading data from the receiver to the 
computer. DCI does not recommend using an adapter with inverter. If AC power is not available, then use 
the laptop’s battery pack. It is not advisable to download data inside an operating vehicle.  

To download data from the receiver to the computer: 

1. Plug the ACTiSYS IR cable into the serial (COM) port on the computer, or use the USB-to-serial 
adapter to connect the cable to a USB port. 

2. Start up the computer and open the DataLog program (see “Starting DataLog Program” in Using 
DataLog Software section). 

3. Select Run Info from the Edit menu, enter the requested data in the Run Information dialog box, 
then click OK. (See “Editing Run Information” in the Editing Data in Computer section.) 

NOTE: You must specify the units for depth (feet or meters) and pitch (percent or degrees) 
in the Run Information dialog box, or these settings will default to feet and percent.  

4. Enter the Rod Len, 1st Rod, and Last Rod information, then hit Enter on your keyboard.  

5. Select a port (1, 2, 3, 4) from the Port menu, then click the Port Open button. The port will automa-
tically open, and you will see “Com1 Port opened” (for example) in the port status field. 

6. Start up the receiver.   

7. From the main menu screen push the toggle to the right a few times to 
select the DataLog option, and click the trigger. Then select the Locate 
DataLog option. 

Click Trigger to 
Start Receiver 

 

 

8. From the DataLog menu, select Send Locate Data, and click the 
trigger. 

9. A pop-up box appears that shows the last run logged. Use the toggle to 
select the correct run for the download. 

10. Place the IR cable over the red IR port on the left side of the receiver’s display window, and click 
the trigger to commence download. The drill data will appear immediately on the computer screen 
if the download is successful. 

NOTE: DCI recommends that you download data for each run at least twice, and save each with a 
different name. For example, you could download and save the data the first time as 
“Riverbore” and the second time as “Riverbore Rev 1”.  
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If you have used the Pitch Only or Blank data option, you will see an Eclipse DataLogger dialog box 
indicating data is missing; click OK. You must input values for the missing data after download or portions 
of the profile will not display (see “Correcting for Taking Pitch Only or Blank Data” in Editing Data in 
Computer section).  

 

Missing Data Dialog Box 

Downloading Hints 
If the data does not download, try another port. To do so, click on the Port Close button to close the cur-
rent port. Then select a different port, click on the Port Open button, and try downloading again.  

To verify the available ports on your computer, select Start | Control Panel | System to open the System 
Properties dialog box. Another way to access the System Properties dialog box is to select Start | My 
Computer and then double click on “View system information” listed under System Tasks on the left side 
of the dialog box.  

 

System Properties Dialog Box Showing Hardware Tab 

44 Eclipse® DataLog® Operator’s Manual 



 Downloading Data 

In the System Properties dialog box, click on the Hardware tab, then the Device Manager button to open 
the Device Manager dialog box, which shows all the hardware devices installed on your computer. 
Double click on Ports to see the current port assignments. You should see “Prolific USB-to-Serial Comm 
Port” with its designated COM port in parenthesis. If it shows this port is designated as COM5 or greater, 
then you must change this to a COM port number of 1, 2, 3, or 4, because the Eclipse DataLog will only 
communicate on ports 1, 2, 3, or 4. 

If you must change the “USB-to-Serial Comm Port” setting, double click on it in the Device Manager 
dialog box to bring up its Properties dialog box. Click on the Port Settings tab, then click on the Advanced 
button to see the Advanced Settings dialog box for that port. Click on the drop-down arrow for the COM 
Port Number in the lower portion of the dialog box as shown below. 

 

COM Port Advanced Settings Dialog Box 
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This shows all of the ports and which ones are in use. Click on COM port 1, 2, 3, or 4, whichever is 
available, and then click OK and close out all of the dialog boxes.   

If COM ports 1, 2, 3, and 4 are already in use, you may have to temporarily reassign one to free up a port 
for the DataLog’s USB-to-Serial Adapter.   

Another remedy to try if the data does not download is to hold the IR cable 2 inches (5 cm) above the red 
IR port on the receiver and/or at a slight angle. You may need to close and reopen the port or exit and 
then reopen the Eclipse DataLog program. 

You may need to disable the IR device. To do this, open the System Properties dialog box as discussed 
in the second paragraph of this subsection. Then, click on the Hardware tab, then the Device Manager 
button to open the Device Manager dialog box. If there is a listing under “Infrared devices”, then double 
click on that to open the Infrared devices Properties box. At the bottom of this dialog box, click on the 
Device usage drop-down arrow and select “Do not use this device (disable).” 

 

Deleting Data from Receiver After Downloading  
After you have downloaded the data for all of the runs recorded in the receiver, you can delete the data 
from the receiver to make room for more runs. You can record up to 25 runs before you have to delete 
data from the receiver. Be sure you have downloaded and saved the data on your computer before you 
delete the data from the receiver. Once the data is deleted from the receiver, it cannot be retrieved. You 
may want to download the same run a few times (using different run information and file names each 
time), so that you have a backup version of the data. 

NOTE: You cannot save more than 25 runs in the receiver at any one time. If you attempt to 
store more than 25 runs before deleting data, you could lock-up the receiver and lose all 
drill data it has stored. This may require the receiver to be returned to DCI for repair. 

To delete all data from the receiver: 

1. Select DataLog from the receiver’s main menu screen, and click the trigger. Then select the 
Locate DataLog option, and click the trigger. 

2. From the DataLog menu, select Delete Locate Data, and click the trigger. 

3. You will see the Delete Locator Data dialog box. Push the toggle to the right to select Y for yes, 
and click the trigger. 

NOTE: When you delete data from the receiver, you will delete ALL data in the receiver. You 
cannot delete specific runs. Be sure you have saved the data on your computer before 
you delete the data from the receiver.  

4. After the data has been deleted, click the trigger. 

5. To return to the main menu screen, push the toggle down two times. 

 

 

46 Eclipse® DataLog® Operator’s Manual 



 DIGITAL CONTROL INCORPORATED  

Editing Data in Computer 
You can edit the drill data in the computer after it has been downloaded. Remember to download data for 
each run at least twice, and save each set of data with a different name, to ensure that you have a 
backup copy of the data. 

Changing the Survey Point 
1. Place the cursor in the Survey Point data box in the Drill Information field, and enter the desired 

value for the survey point. Remember to add a minus sign (“–”) if the value is negative (that is, if 
the last data point was lower than the first data point). 

2. Click the PLOT button, and the graph in the profile view field will automatically be updated.  

 

Editing Run Information 
1. Select Run Info from the Edit menu. You will see the Run Information dialog box shown below.  

2. Edit the information as needed, then click OK.  

    

Run Information Dialog Box 
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Changing Last Rod Data 
You can change the last rod data after it is downloaded if necessary. For example, you may want to 
change the value if more accurate information for the last rod is obtained. To change the last rod data: 

1. Select Last Rod Data from the Edit menu. You will see the Last Rod Data dialog box, as shown 
below. 

 

Last Rod Data Dialog Box 

2. Enter the desired values for pitch and depth, then click OK. You will see the data updated in the 
DATA field, with an asterisk (“*”) in the Type column to indicate the data in that field has changed, 
and a shift in the profile view to reflect the changed values. 

NOTE: If you do not enter a value for one of the fields, it will default to zero (“0.0”) and distort 
the profile. 

 

Changing Data or Adding Comments in DATA Field 
1. In the DATA field, double-click on the row that needs to be changed, and the Data Record dialog 

box (shown below) will appear.  

 

Data Record Dialog Box 

2. Place your cursor in the Pitch, Depth, or Comments field and make the appropriate changes, 
then click OK. You will see the graph be replotted using the new data. 

3. Note that an asterisk (“*”) will appear in the Type column, which indicates that the data has been 
changed.  
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Correcting for Taking Pitch Only or Blank Data 
As discussed earlier (see Using DataLog Menus on Receiver section), there may be instances where you 
are not able to position the receiver over the front locate point or within range of the transmitter to record 
data. In these cases you selected the Pitch Only or Blank data recording option.  

Once the data is downloaded to the computer, you can enter values for these data points if you ant the 
gaps in the graph filled in. When you download the data, the DataLog software estimates or “interpolates” 
a value for the data, based on the information for adjacent data points. You must either accept the 
interpolated value or enter a new value for the data. 

To correct the data: 

1. In the DATA field, double-click on the row that needs to be changed, and the Data Record dialog 
box will appear, as shown above. 

2. Either change the values as desired or accept the estimated or interpolated values by clicking in 
the Accept default checkbox. Then click OK. 

3. You will see the graph be replotted using the new data. 

4. Note that an asterisk (“*”) will appear in the Type column, which indicates that the data has been 
changed. 

 

Editing, Inserting, or 
Deleting Rod Data 
You can easily change, add, or delete rod data 
given in the DATA field. Simply place the cursor 
in the row of data you would like to change and 
right click. You will see a popup menu with the 
options to Edit, Insert, or Delete. 

To edit a row of data, place the cursor on the row 
you want to edit, right click, and then select the 
Edit menu. You will get the Data Record dialog 
box, where you can change the data (see 
“Changing Data or Adding Comments in DATA 
Field” above). After editing a row of data, an asterisk (“*”) will appear in the Type column to denote that 
the data was changed after download, and the plot in the profile view will change to show the new data.  

 

To insert a new row of rod data, place the cursor on the row before the rod you want to add, right click, 
and then select the Insert menu. You will get the Data Record dialog box, where you can input the 
information for the new row of data (see “Changing Data or Adding Comments in DATA Field” above). 
After inserting a row of data, an “a” will appear in the Type column to denote the row has been added, 
and the plot in the profile view will change to show the new data. 

NOTE: You cannot insert a rod (or rods) before the first data point. 

Eclipse® DataLog® Operator’s Manual 49 



Editing Data  

To delete a row of data, place the cursor on the row you want 
to delete, right click, and then select the Delete menu. You will 
get the EclipseDataLogger Message dialog box where you 
can confirm the deletion by clicking on Yes or exit back to the 
project data screen. Note that the plot in the profile view 
changes to show the change in data. 

 
 

NOTE: It is a good idea to enter a comment when editing or adding rods so that you can 
readily see what the change was when you view the row of data in the DATA field. 

Formatting Profile View Graph 
You can customize the look of your profile view graph by using the 2D Chart Control Properties dialog 
box. To access this dialog box, place your mouse in the profile view area and click the right mouse 
button. The most useful tips for sizing the profile view graph are described below. 

 

2D Chart Control Properties Dialog Box Showing X-Axis Scale Tab 

Resizing Graph to Reduce Excess White Space  

1. In the 2D Chart Control Properties dialog box, click on the Axes tab. 

2. To adjust the X-axis scale, click on the X in the Axes box in the top left area. 

3. Click on the Scale tab. 

4. Highlight the value in the Max box (as shown above in the 2D Chart Control Properties Dialog 
Box graphic), and then type in a number for the horizontal distance; we recommend that you 
choose a value just beyond the end of the bore. 

5. Click on the Apply button, and you will see the scale for the X-axis adjust in the profile view. 
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6. To adjust the Y-axis scale, click on the Y in the Axes box in the top left area. 

 

2D Chart Control Properties Dialog Box Showing Y-Axis Scale Tab 

7. Under the Scale tab, type in values for the Max and Min boxes. The Max box adjusts the amount 
of white space above the X-axis; the Min box adjusts the amount of white space below the X-axis. 

8. Click Apply or OK to adjust the graph. 

Moving T Flag (Termination Flag) to End of Bore 

1. In the 2D Chart Control Properties dialog box, click on the ChartLabels tab. 

 

2D Chart Control Properties Dialog Box Showing  
ChartLabels Tab with Finish Flag Selected 
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2. Click on the word Finish under ChartLabels in the box in the top left area. 

3. Click on the AttachMethod button to open the Select AttachMethod dialog box. 

 

Select AttachMethod Dialog Box  

4. Place your cursor in the X box, as shown above. 

5. Type in the maximum horizontal distance of your bore (under Distance column in the DATA field). 

6. Place your cursor in the Y box, and type in the iDepth (or integrated depth) value for the Last Rod 
measurement (under iDepth column in the DATA field). 

7. Click OK, and you will see the graph adjust. 

Removing the S and T Flags 

1. In the 2D Chart Control Properties dialog box, click on the ChartLabels tab. 

2. Select the Start flag in the box in the upper left area. 

3. Click the Remove button below the box. The S flag will be deleted. 

4. Select the Finish flag in the box in the upper left area. 

5. Click the Remove button below the box. The T flag will be deleted. 

6. Click OK to exit the 2D Chart Control Properties dialog box. 

Renaming the S and T Flags 

It is possible to rename the S and T flags to better define the profile’s data, such as using the directions 
North, South, East, and West. Using the S flag as an example, we will rename the flag North. 

1. In the 2D Chart Control Properties dialog box, click on the ChartLabels tab. 

2. Click on the word Start under ChartLabels in the box in the top left area, and then highlight the 
word Start in the Name box. 
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2D Chart Control Properties Dialog Box Showing  
ChartLabels Tab with Start Flag Selected 

3. Type in the new name of the flag, which in this case is North, and then click OK. Note that the 
name changed in the box to the left also. 

 

2D Chart Control Properties Dialog Box Showing  
ChartLabels Tab with Start Flag Renamed 

4. Click on the Label tab, and then type the word North in the text box. 

5. Click OK to exit the Chart Properties dialog box. Note that the changes have been made in the 
Profile View area. 
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LIMITED WARRANTY 
Digital Control Incorporated (“DCI”) warrants that when shipped from DCI each DCI product (“DCI Product”) will 
conform to DCI’s current published specifications in existence at the time of shipment and will be free, for the 
warranty period (“Warranty Period”) described below, from defects in materials and workmanship. The limited 
warranty described herein (“Limited Warranty”) is not transferable, shall extend only to the first end-user (“User”) 
purchasing the DCI Product from either DCI or a dealer expressly authorized by DCI to sell DCI Products 
(“Authorized DCI Dealer”), and is subject to the following terms, conditions and limitations: 

1. A Warranty Period of twelve (12) months shall apply to the following new DCI Products:  receivers/locators, 
remote displays, battery chargers and rechargeable batteries, and DataLog® modules and interfaces. A Warranty 
Period of ninety (90) days shall apply to all other new DCI Products, including transmitters, accessories, and 
software programs and modules. Unless otherwise stated by DCI, a Warranty Period of ninety (90) days shall 
apply to:  (a) a used DCI Product sold either by DCI or by an Authorized DCI Dealer who has been expressly 
authorized by DCI to sell such used DCI Product; and (b) services provided by DCI, including testing, servicing, 
and repairing an out-of-warranty DCI Product. The Warranty Period shall begin from the later of:  (i) the date of 
shipment of the DCI Product from DCI, or (ii) the date of shipment (or other delivery) of the DCI Product from an 
Authorized DCI Dealer to User. 

2. DCI's sole obligation under this Limited Warranty shall be limited to either repairing, replacing, or adjusting, at 
DCI's option, a covered DCI Product that has been determined by DCI, after reasonable inspection, to be 
defective during the foregoing Warranty Period. All warranty inspections, repairs and adjustments must be 
performed either by DCI or by a warranty claim service authorized in writing by DCI. All warranty claims must 
include proof of purchase, including proof of purchase date, identifying the DCI Product by serial number. 

3. The Limited Warranty shall only be effective if:  (i) within fourteen (14) days of receipt of the DCI 
Product, User mails a fully-completed Product Registration Card to DCI; (ii) User makes a reasonable 
inspection upon first receipt of the DCI Product and immediately notifies DCI of any apparent defect; and 
(iii) User complies with all of the Warranty Claim Procedures described below. 

WHAT IS NOT COVERED 
This Limited Warranty excludes all damage, including damage to any DCI Product, due to:  failure to follow DCI’s 
user’s manual and other DCI instructions; abuse; misuse; neglect; accident; fire; flood; Acts of God; improper 
applications; connection to incorrect line voltages and improper power sources; use of incorrect fuses; 
overheating; contact with high voltages or injurious substances; or other events beyond the control of DCI. This 
Limited Warranty does not apply to any equipment not manufactured or supplied by DCI nor, if applicable, to any 
damage or loss resulting from use of any DCI Product outside the designated country of use. By accepting a DCI 
Product and not returning it for a refund within thirty (30) days of purchase, User agrees to the terms of this 
Limited Warranty, including without limitation the Limitation of Remedies and Liability described below, and 
agrees to carefully evaluate the suitability of the DCI Product for User's intended use and to thoroughly read and 
strictly follow all instructions supplied by DCI (including any updated DCI Product information which may be 
obtained at the above DCI website). In no event shall this Limited Warranty cover any damage arising during 
shipment of the DCI Product to or from DCI. 

User agrees that the following will render the above Limited Warranty void:  (i) alteration, removal or tampering 
with any serial number, identification, instructional, or sealing labels on the DCI Product, or (ii) any unauthorized 
disassembly, repair or modification of the DCI Product. In no event shall DCI be responsible for the cost of or any 
damage resulting from any changes, modifications, or repairs to the DCI Product not expressly authorized in 
writing by DCI, and DCI shall not be responsible for the loss of or damage to the DCI Product or any other 
equipment while in the possession of any service agency not authorized by DCI. 
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DCI reserves the right to make changes in design and improvements upon DCI Products from time to time, and 
User understands that DCI shall have no obligation to upgrade any previously manufactured DCI Product to 
include any such changes. 

The foregoing Limited Warranty is DCI’s sole warranty and is made in place of all other warranties, express or 
implied, including but not limited to the implied warranties of merchantability and fitness for a particular purpose 
and any implied warranty arising from course of performance, course of dealing, or usage of trade. If DCI has 
substantially complied with the warranty claim procedures described below, such procedures shall constitute 
User’s sole and exclusive remedy for breach of the Limited Warranty. 

LIMITATION OF REMEDIES AND LIABILITY  
In no event shall DCI nor anyone else involved in the creation, production, or delivery of the DCI Product 
be liable for any damages arising out of the use or inability to use the DCI Product, including but not 
limited to indirect, special, incidental, or consequential damages or for any cover, loss of information, 
profit, revenue or use based upon any claim by User for breach of warranty, breach of contract, 
negligence, strict liability, or any other legal theory, even if DCI has been advised of the possibility of 
such damages. In no event shall DCI’s liability exceed the amount User has paid for the DCI Product. To 
the extent that any applicable law does not allow the exclusion or limitation of incidental, consequential 
or similar damages, the foregoing limitations regarding such damages shall not apply. 
This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state. This Limited Warranty shall be governed by the laws of the State of Washington. 

WARRANTY CLAIM PROCEDURES 
1. If you are having problems with your DCI Product, you must first contact the Authorized DCI Dealer where it 
was purchased. If you are unable to resolve the problem through your Authorized DCI Dealer, contact DCI’s 
Customer Service Department in Kent, Washington, USA at the above telephone number between 6:00 a.m. and 
6:00 p.m. Pacific Time and ask to speak with a customer service representative. (The above “800” number is 
available for use only in the USA and Canada.)  Prior to returning any DCI Product to DCI for service, you must 
obtain a Return Merchandise Authorization (RMA) number. Failure to obtain a RMA may result in delays or return 
to you of the DCI Product without repair. 

2. After contacting a DCI customer service representative by telephone, the representative will attempt to assist 
you in troubleshooting while you are using the DCI Product during actual field operations. Please have all related 
equipment available together with a list of all DCI Product serial numbers. It is important that field troubleshooting 
be conducted because many problems do not result from a defective DCI Product, but instead are due to either 
operational errors or adverse conditions occurring in the User’s drilling environment. 

3. If a DCI Product problem is confirmed as a result of field troubleshooting discussions with a DCI customer 
service representative, the representative will issue a RMA number authorizing the return of the DCI Product and 
will provide shipping directions. You will be responsible for all shipping costs, including any insurance. If, after 
receiving the DCI Product and performing diagnostic testing, DCI determines the problem is covered by the 
Limited Warranty, required repairs and/or adjustments will be made, and a properly functioning DCI Product will 
be promptly shipped to you. If the problem is not covered by the Limited Warranty, you will be informed of the 
reason and be provided an estimate of repair costs. If you authorize DCI to service or repair the DCI Product, the 
work will be promptly performed and the DCI Product will be shipped to you. You will be billed for any costs for 
testing, repairs and adjustments not covered by the Limited Warranty and for shipping costs. In most cases, 
repairs are accomplished within 1 to 2 weeks. 

4. DCI has a limited supply of loaner equipment available. If loaner equipment is required by you and is available, 
DCI will attempt to ship loaner equipment to you by overnight delivery for your use while your equipment is being 
serviced by DCI. DCI will make reasonable efforts to minimize your downtime on warranty claims, limited by 
circumstances not within DCI’s control. If DCI provides you loaner equipment, your equipment must be received 
by DCI no later than the second business day after your receipt of loaner equipment. You must return the loaner 
equipment by overnight delivery for receipt by DCI no later than the second business day after your receipt of the 
repaired DCI Product. Any failure to meet these deadlines will result in a rental charge for use of the loaner 
equipment for each extra day the return of the loaner equipment to DCI is delayed. 
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